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Unit 1: 
Orientation to SAMS 

 
 
 

Unit Overview 
 
The State Aid Management System (SAMS) is a secure information system that facilitates the 
collection and processing of data required by the New York State Education Department 
(NYSED) to distribute annual state aid to all New York school districts. SAMS is accessible to 
authorized users from each school district, staff from the State Aid unit of the Education 
Department, and other authorized users from various state agencies. 
 
In this unit, you will learn how to log in and out of SAMS.  An overview of the header and menu 
options will also be provided in this unit. 
 
 



 

  Page 5 
 

 

Logging In and Out of SAMS 
 
Overview 
 
SAMS is an Internet-based application allowing users to enter and retrieve information from any 
computer with an Internet connection and Internet Explorer 6.0 or greater. SAMS users login to 
the application through the NYSED’s Application Portal and Single Sign-On (SSO) facilities.  
 
The Application Portal is the entry point into all NYSED Internet applications. All NYSED 
applications you are authorized to access are accessible from this page. Some applications, such 
as SAMS, require user name and password authentication. NYSED’s Single Sign-On service, 
accessible from the Portal page, prompts you for your user name and password and then decides 
which applications, like SAMS, you are authorized to use.  
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Logging in  
 
Establish an internet connection in order to run the SAMS application: 
 

1. You access SAMS through the New York State Education Department Application Portal at 
http://portal.nysed.gov.  

 

 
 
 

2. After the Portal page appears, click on the ‘Log On’ menu option in the upper right hand side of 
the page. 

3. The Single Single-On dialog box appears.  
 

 
 

http://portal.nysed.gov
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4. You are prompted to enter a valid User Name and Password in the two text boxes provided. 

Both the User Name and Password should have been previously setup for you. If this has not 
occurred please contact NYSED. 

 
5. After you enter your User Name and Password, press the Login button on the upper right hand 

side of the page.  You will receive a Security Alert:.  Press the ‘Yes’ button on the Security Alert 
to continue.  You will then be directed back to the to the NYSED Portal. 

 

 
 
 

6. Find the ‘My Applications’ tab on the page and click on the ‘State Aid Management System 
(SAMS)’ hyperlink.  The SAMS Homepage will appear. 

 
 

Important Information: If you enter an invalid User Name or Password, Single Sign-On 
will return the following error message- ‘Error: Authentication failed. Please try again.’  If 
you forgot your User Name or Password, you must contact the SAMS Help Desk. 

 
 

Notes:  
 

 Your User Name is tied to a system role. Your system role determines what you can and cannot 
do on the system, including which districts you have access to. Users that are associated with a 
single district will only have access to their district’s data. A system role is assigned to you at the 
same time your User Name and Password are registered in the Single Sign-On directory. 

 If for some reason, your User Name and Password are not associated with the SAMS 
application, you will not find SAMS in the ‘My Applications’ tab of the Portal Page. 

 If you want to change your password to SAMS and any other NYSED applications you are 
authorized to access from the NYSED Portal, select the ‘Change Password’ menu option on the 
upper right hand side of the Portal page. 
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Logging out 
 
1. Click on Logout from the SAMS menu bar.  You will find it located on the upper right side of any 

SAMS page.  
 

 
 

 
Important Information:  If you click on Logout when you are on a SAMS form and have 
entered data into the form without saving, SAMS will warn you that you are about to exit 
the application and will provide you with an option to save your data. 

 
 
2. After clicking on Logout, you will receive a Security Information screen.  Click either ‘Yes’ or ‘No’ 

on the Security Information screen to continue.  You will then be directed to the Single Sign-Off 
page.  You can sign back on to the application by clicking on the Return button. This will redirect 
you back to the NYSED Portal Application. 
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Session Timeout 
 
SAMS is an online, Web-based application. When you log on to SAMS, the system establishes a 
‘session id’ for your visit and each time you go through the log on process you are assigned a 
unique ‘session id’.  
 
New York State information security standards mandate that all online applications have a 
session timeout set. For the SAMS application, the established session timeout is three (3) 
hours. This means that if you log on to the SAMS application and there is no activity detected 
by the application in any consecutive three-hour period, your session will be terminated. If 
session termination occurs, any work you’ve done on the system during the past three-hours 
could be lost. 
 
It is important to understand that SAMS can only detect activity when you exchange information 
with the Web server. Therefore, if you are working in a SAMS form, enter some data, and walk 
away from the application for three hours, your data entry work will be lost if you did not save 
before the session timeout occurred. 
 

Important Information:  When working in forms and entering your data, save often by 
clicking the Save button or using the ALT-S hot key. 
 
It is never a good security practice to leave an application open and unattended for long 
periods of time. 
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Summary 

 
SAMS Login and Logout are simple processes to follow. To Login to SAMS, the user must have 
a valid User Name and Password that has been previously registered with the Single Sign-On 
directory. For security reasons, you should remember to always logout of SAMS if you are 
leaving the area of your computer for an extended period of time. 
 
If any problems are encountered during the login process, please call the SAMS Helpdesk for 
assistance. 
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Overview of Header and Menu Bar Options 
 
Overview 
 
SAMS has a single header and menu bar that is accessible from any SAMS page. The header and 
menu bar are accessible from any location in the application. Users may move through any 
function in the application regardless of where they are working and quickly navigate to other 
areas of the application.  
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Header Description 
 
The SAMS header is used to view and set the district context. The SAMS header includes fields 
for a district Name, BEDS Code, and a Claim Year. For users who have a role that assigns 
them to just one district, both the district Name and BEDS Code fields are read-only. Just the 
Claim Year can be selected and changed for these users. For users that have access to multiple 
districts, the Name, BEDS Code, and Claim Year fields can be accessed and changed. 
Whenever a change is made to header information in these fields the user must click on the Set 
Values button to invoke the change. 
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Menu Bar Options 
 
Entity Info 
This menu bar option provides access to data stored in another NYSED information system 
called SEDREF.  This system contains extensive demographic information about institutions that 
interact with NYSED. The Entity Info page in SAMS displays SEDREF information associated 
with the current district set in the SAMS header. Information includes basic district attributes, 
such as district code, BOCES code, District Type, District Superintendent, RIC Code, and 
BOCES Comp. Key contacts associated with the district are also listed and authorized users can 
edit the information for these SAMS contacts. 
 
Claim Verifications 
This menu bar option provides access to all screens related to the Claim Verification process. 
 
Forms 
This menu bar option provides access to all State Aid data collection forms. To support the form 
selection process a Form Tree is provided that divides forms into form sets. Each form set is a 
sub-folder on the Form Tree and all forms associated with a form set are associated with the 
folder. The Forms menu option has the following sub-menus: Official Data, Revision Data, 
Import Form Data, and Print Multiple Forms. 
 
Both the Official Data and Revision Data options represent data areas in SAMS. The Official 
Data area always holds the official data as it exists in the system. The Revision Data area holds 
updates or edits to the official data area when a district needs to revise their official submittal. A 
user utilizes the Form Tree to find, select, and load a form for data entry or review. 
 
The Import Form Data sub-menu option allows a district to bypass the manual form data entry 
process and electronically load data into SAMS from a file import process.  This file import 
process utilizes the same data validation process as if the data were being entered onto the forms 
manually. 
 
The Print Multiple Forms sub-menu option allows a district to print more than one form at the 
same time.  A Form Tree is presented to the user with check-boxes next to the name of each form 
set and form which allow the user to choose the forms they would like to print.  The user also has 
the option of choosing the data area they want to print their forms from or to print blank forms.  
After a user selects their forms and printing options, they can click on the ‘Print Selected 
Forms’ hyperlink to print the forms.  The selected forms will appear in a separate browser 
window from which the user can preview and print them. 
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Activity Log 
This menu bar option provides access to the SAMS Activity Log. The Activity Log captures all 
status changes of all form sets for a given district. Users can review the Activity Log to see when 
key milestone events occurred related to a given form set. For example, the Activity Log can be 
used to see when a given form set was Certified. The Activity Log also tracks notification events, 
which are typically automatic emails sent by SAMS when a certain event trigger occurs. Users 
with the appropriate security privilege can also use the Activity Log to enter their own 
correspondence activities. 
 
Home 
This menu bar item brings you back to the SAMS home page. 
 
Issue Reporting 
This menu bar item launches the users default email application and pre-populates an email to 
the SAMS Helpdesk with a standard template for reporting issues. 
 
Help 
The SAMS Online Help module for the application provides information on all features. 

 
Logout 
This option is used to exit the SAMS application.  Once selected, you will be directed to the 
Single Sign-Off page.  See the Logging out section for important details on logging off correctly. 
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Summary 
 
The SAMS header and menu bar is available from all pages within the application. The content 
of the menu bar is determined by a user’s security access role. All users will not see the same 
options on the menu bar. If there are functions available and you do not have access to them but 
believe you should have access, please contact the SAMS Help Desk.
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Unit 2: 
Working with Forms- Part I 

 
 
 

Unit Overview 
 
Working with forms is a major activity in SAMS for all district users. Forms are used to collect 
and display all pertinent district information related to State Aid. SAMS is designed to hold 
multiple claim years of State Aid and, therefore, supports a library of forms for each claim year. 
SAMS allows you to specify a claim year of interest and then it retrieves all the forms associated 
with that claim year and any data related to your district.  
 
In this unit, you will learn how to select a form, fill out and save a form, print a form, and use the 
file import mechanism to load form data from a file rather than via manual input. 
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Opening a Form  
 
To open a SAMS Form follow these steps: 
 

1. Make sure you set the form access context. To do this, notice the current settings on the SAMS 
header. The district Name should be set to your district, as should be the BEDS Code. Both of 
these settings are read-only for district users. The Claim Year, by default, should be set to the 
current claim year when you first logon. This setting can be changed by you to the desired claim 
year. This is the only setting district users can change in the header. For this example, change the 
claim year to ‘2003-2004’ and click on the Set Values button. A message will appear confirming 
your selection. 

 
2. From the SAMS main menu, run your mouse over the Forms menu option, and click on the 

Official Data sub-menu option (in the next unit, we’ll talk about data areas). 
 

 
 
 

 
 

 
3. SAMS returns the Form Tree for the Official Data. Open a menu folder by clicking on the plus 

sign (+) next to the folder or on the name of the folder.  The form selection tree expands the 
folder to reveal its subcomponents.  The subcomponents of a menu folder include a listing of the 
forms and schedules contained within it.  An expanded folder can be collapsed by clicking on the 
minus sign (-) next to it or on the name of the folder. 
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4. The status of each of the data collection forms and schedules within the opened folder is 
displayed next to their name on the form selection tree (e.g. ‘Saved’).   Forms and schedules that 
have not yet been saved by a user (i.e. have a Null status) will not have a status displayed next to 
their name, even though there may be some data pre-populated on them. 
 
 

5. Click on the name of the form you want to open.  The data collection form is displayed for the 
entity and claim year that have been set in the top left-hand corner of the application.  To review 
the forms associated with a different claim year, select a year from the Claim Year box located in 
the top-left corner of the application and click the Set Values button. 

 
 

Important Information: Always make sure you have set the appropriate claim year before 
accessing form data. 
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Entering and Saving Form Data  
 
The following steps explain how to enter and save data into any form: 
 
1. Place the cursor in the field that you want to enter data for.  Note that read-only fields will appear 

grayed out and will not allow you to modify the data within them. 
 

 
 
2. Enter your data. 
 
3. Press the TAB key to move to the next form field and continue entering data.  Note that pressing 

SHIFT+TAB will move the cursor to the previous form field. 
 
4. Press the Save button at the bottom of the form to save the data you have entered.  Note that ALT+S 

is a shortcut keystroke that will allow you to Save your data from anywhere on the form while 
maintaining your current position on the form.  Note also that calculated form fields, such as subtotals 
and totals, are re-calculated when the form is saved. 
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5. Press the Reset button at the bottom of the form if you want to cancel your unsaved changes and reset 

the form to its previously saved data.  Note that ALT+C is a shortcut keystroke that will allow you to 
Cancel/Reset your data from anywhere on the form. 

 
6. Press the Save & Ready button at the bottom of the form to save the data you have entered and 

simultaneously change the status of the form to ‘Ready’.  Note that ALT+R is a shortcut keystroke 
that will allow you to Save & Ready your data from anywhere on the form. 

 
 
 

Important Information: In Unit 3- Working with Forms Part 2, we’ll talk more 
extensively about the form status and the relationship with the Save and Save & Ready 
button. 
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Adding Comments to Form Fields  
 
The following steps explain how to enter and save form data: 
 
1. With the cursor in the field that you want to add a comment to or review the comments of, press the 

F7 button.  A separate window will appear that will allow you to enter a comment and view any other 
comments related to the current field value.  Comments cannot be added to read-only fields. 

 

 
 
2. Add your new comment in the designated box.  Note that the history of any previously added 

comments for the current field, including those added by other users, will also be displayed in this 
window. 

 
3. Click the Add Comment button and then close the comments window by clicking on the 'X' located 

in the top right-hand corner of the window or by pressing ‘CTRL+W’. 
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4. Save the form.  Comments are equivalent to the data that is entered into each form field and are not 
saved until the form has been saved.  When there are saved comments associated with a field, a 
checkmark icon will be displayed to the right of that field.  If the cursor is held over the icon with the 
mouse then the most recent comment for that field will be displayed. 

 

 
 

 
Important Information: If a form is in the NULL or SAVED status, the data and 
comments are not being versioned (i.e. the old field values and comments are overwritten 
in the database when a new value or comment is entered and saved).  Because the field 
values and comments are not being versioned during these statuses, the previous comments 
on a field will no longer be available when a user changes that field’s value and saves the 
form.  There may be historical comments associated with previous values for a field that 
can be accessed by pressing the F7 key, but the checkmark icon is only displayed next to 
fields when there are comments associated with the current field value. 
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Printing a Form 
 
 

Printing a Form with Data 
 
The following steps explain how to print a form with data: 
 
1. Open the form you want to print. 
 
2. Select the Print Form link located in the top right corner of the form.  A new window will open 

displaying a ‘printer friendly’ version of the form. 
 

 
 

NOTE:  The Print Text Only link may also be available in the top right corner of the form.  This 
print option is similar to the Print Form option, except the input boxes that surround each data field 
are removed from the printed form. 
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3. From the File menu of the new window, click Print.  A new print options window will open. 
 

 
 
 
4. Set the printing options you want and click the Print button. 
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Important Information: SAMS will open a new browser window under a few 
circumstances- print forms and comments. To close these additional browser windows, you 
must click on the ‘X’ box in the upper right hand corner of the browser window or by 
pressing ‘CTRL+W’. 
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Printing a Blank Form 
 
The following steps explain how to print a blank form: 
 
1. Open the form you want to print. 
 
2. Select the Print Blank link located in the top right corner of the form.  A new window will open 

displaying a ‘printer friendly’ version of the form. 
 

 
 
 
3. From the File menu of the new window, click Print.  A new print options window will open. 
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4. Set the printing options you want and click the Print button. 
 

 
 
 

Important Information: SAMS will open a new browser window under a few 
circumstances- print forms and comments. To close these additional browser windows, you 
must click on the ‘X’ box in the upper right hand corner of the browser window (or press 
CTRL+W). 
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Printing a Selected Part of a Form 
The following steps explain how to print a selected part of a form: 

1. Open the form you want to print. 
 
2. Select either the Print Form or Print Blank link located in the top right corner of the form, 

depending on whether or not you want to print the form with data.  A new window will open 
displaying a ‘printer friendly’ version of the form. 

 
3. Hold the left mouse button down and drag the cursor over the portion of the form that you want to 

select for printing. 
 

 
 



 

  Page 29 
 

4. From the File menu of the new window, click Print.  A new print options window will open. 
 

 
 
5. In the Page Range section of the General tab, choose the Selection option.  If this option is not 

available or selectable, then you have not selected a portion of the form to print (see step 3). 
 
6. Set the other printing options you want and click the Print button. 
 
 

Important Information: SAMS will open a new browser window under a few 
circumstances- print forms and comments. To close these additional browser windows, you 
must click on the ‘X’ box in the upper right hand corner of the browser window (or press 
‘CTRL+W’). 
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Printing Multiple Forms 
 
The following steps explain how to print multiple forms at the same time: 
 
1. From the SAMS main menu, run your mouse over the Forms menu option, and click on the Print 

Multiple Forms sub-menu option.  SAMS displays the Print Multiple Forms screen.  This screen 
includes a Form Tree for selecting the forms you would like to print. 

 

 
 
2. Select a Data Area, or other print option, from the Select Data Area drop-down box. 
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3. Select a form to print by clicking on the check box next to the name of the form.  A checkmark will 

appear in the check box.  All of the forms in a particular form set can be simultaneously selected for 
printing by clicking on the check box next to the name of the form set. 

 

 
 
4. Unselect a form or form set by clicking on the check box next to the name of the form or form set.  

The checkmark will be removed from the check box. 
 
5. Click the Print Selected Forms link.  A pop-up message will appear stating that the number of forms 

selected for printing may take some time to print. 
 
6. Click OK to continue with the printing operation.  SAMS will display a printable version of all the 

selected forms in a separate browser window.  The forms are displayed and printed in the order they 
appear on the Form Tree.  Otherwise, click Cancel if you do not want to continue with  the printing 
operation. 

 
7. From the File menu of the new browser window, click Print.  A new print options window will open. 
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8. Set the printing options you want and click the Print button. 
 

 
 
 

Important Information: SAMS will open a new browser window under a few 
circumstances (e.g. print forms and display field comments).  To close these additional 
browser windows, you must click on the ‘X’ box in the upper right hand corner of the 
browser window (or press CTRL+W). 
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Importing Form Data from a File 
SAMS allows users to electronically import data that is collected on the State Aid forms using a 
pre-defined text file format. 

1. Select the Import Form Data submenu item from the Forms main menu located near the top of the 
screen.  The Electronic File Import screen will appear. 

 

 
 
2. Select a Data Area to import the data into (e.g. Official). 
 
3. Click the Browse button to browse your computer and select a file to import. 
 
4. Click the Import button. 

Important Information: The results of the file import process will be displayed at the 
bottom of the screen.  If an item in the file is not valid, then that record in the file will not 
be loaded into SAMS.  The items that were not successfully loaded into SAMS must be 
corrected in the import file (based on the direction provided by the import results) and 
imported again. 
 
The SAMS file import format is the same as the file import format used by DEA. If you 
have successfully completed a DEA file import in the past, similarly formatted files should 
import to SAMS. Please be aware that SAMS implements a strict enforcement of the file 
import specification, which requires both header and end-of-file markers. The file format 
specification is available at: 
http://edlink.nysed.gov/sams/SAMS_file_imp_specs_062005.htm 

 

http://edlink.nysed.gov/sams/SAMS_file_imp_specs_062005.htm
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Unit 3: 
Getting and Using Help 

 
 
 

Unit Overview 
 
Help is an important feature of any application.  The help files for SAMS can be accessed from 
anywhere within the application. SAMS help is context sensitive and can provide users with a 
built-in table of contents, index, search facility, and glossary. 
 



 

  Page 35 
 

 
 

Accessing Help 
 

Click the Help link located near the top-right corner of the application to access help.  A separate 
window containing all of the help content for SAMS will appear.  Pressing the F2 function key is 
a keyboard shortcut that will also launch the SAMS help window.  The F1 function key is 
reserved for the help content of the browser being used to display the SAMS application. 

 

 

To scroll through a table of contents for help, click the Contents tab.  When you want to find 
specific keywords, click the Index tab and type your word(s) in the designated box.  A Search 
tab is available to search for topics that contain references to the word(s) you enter in the search 
box.  Definitions for common terms can be viewed in the Glossary tab. 
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Printing a Help Topic 
 
To print a help topic: 
 
1. From the File menu of the help window, click Print.  A new print options window will open. 
 
2. Set the printing options you want and click the Print button. 
 
. 

Important Information: If everything displayed in the help window prints, including the 
frame on the left that contains the Contents tab, then change your printing options.  Under 
the Options tab in the print options window, select the option to print ‘Only the selected 
frame’ and left-click the mouse on the topic you want to print before printing it 
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About Context-Sensitive Help 
 
Context-sensitive help provides information relevant to the task the user is currently trying to 
accomplish, such as entering data on a form.  Where enabled, the following types of context-
sensitive help are available in SAMS: 
 

 Form-level Help:  When the cursor is not in a particular field on a form and help is 
accessed, the help topic specific to that form is displayed. 

 
 Field-level Help:  When the cursor is in a particular field on a form and help is accessed, 

the help topic specific to that field is displayed. 
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Unit 4: 
Working with Forms- Part II 

 
 
 

Unit Overview 
 
In Unit 2- Working with Forms- Part I, an overview of how to interact with SAMS forms was 
provided. In this unit, additional information will be presented on working with SAMS forms. 
Information on the form status indicator will be presented so that you gain an understanding of 
how your forms move through the SAMS workflow process. The SAMS edit exception report 
process will also be presented. Finally, information on how to certify your State Aid data 
submittals will be outlined.  
 



 

  Page 39 
 

 
 

Understanding the Status of Forms 
The State Aid data collection forms are logically grouped into components know as ‘form sets’. 
For example, Form A and all of its related schedules are considered a form set.  Forms and form 
sets achieve various statuses as they are processed through SAMS.  These statuses are used to 
control system functions and workflow-type activities. 

Status is controlled at the form level, but can be rolled up to the form set level using pre-defined 
business logic.  In addition, there may be dependencies between statuses that dictate the 
status(es) that must precede another status before it can be achieved.  The status of each form and 
form set is displayed next to its name on the Form Selection Tree.  If the status is Null, however, 
nothing will be displayed next to the name of the form or form set.  A summary of the statuses is 
provided in the table below.  The statuses in the table are listed in the approximate order in 
which they are achieved as the forms are processed through SAMS. 

 

Status Description 

Null Represents the status of a form before a user 
has begun entering and saving data to it. 

Saved Represents the status of a form when a user 
begins saving data to it.  

Valid prior status- Null, Saved 

Ready Represents the status of a form when a user 
has completed entering and saving data to it. 
 The user must press the ‘Save & Ready’ 
button to change the status of the form to 
Ready. 

Valid prior status- Null, Saved, Ready 
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Status Description 

Certified Represents the status when the form set of a 
school entity has been certified by the 
Superintendent.  Certification simultaneously 
acts as the official submission of the form set 
data to NYSED.  Form sets are certified 
separately through the use of a certification 
form that is specific to each form set.  The 
Edit Exception Report(s) associated with a 
form set must be in the Ready state before the 
form set can be certified.  After certification 
school entities have read-only access to their 
forms in the Official Data Area, but they 
could enter changes in the Revision Data 
Area. 

Valid prior status- Ready 

Edit in Progress Represents the status when NYSED begins 
their edit process of a school entity’s form set. 
 School entities will not be able to submit 
changes to their data while the associated 
form set is in this status. 

Valid prior status- Certified, Edit 
Rejection, Corrections Submitted 

Edit Rejection Represents the status when NYSED rejects an 
Edit Exception report of a school entity’s 
form set during their edit process. 

Valid prior status- Edit in Progress 

Corrections Submitted Represents the status when a school entity re-
submits a form set with corrected items 
during the edit process. 

Valid prior status- Edit Rejection 

Corrections In Progress Represents the state of the data when NYSED 
has begun reviewing a district's corrections. 

Valid prior status- Corrections Submitted 

Corrections Accepted Represents the status when NYSED accepts 
the submitted corrections. 

Valid prior status- Corrections In Progress 
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Status Description 

Corrections Rejected Represents the status when NYSED rejects 
the corrections submitted by a school entity.   

Valid prior status- Corrections In Progress 

Clean Represents the status when all edit exceptions 
have been adequately explained and the edit 
process is complete.  If there are no edit 
exceptions when a form set is 
certified/submitted, then the system will 
automatically change the status to Clean and 
the manual edit process will be avoided. 

Valid prior status- Certified, Edit in 
Progress, Corrections Accepted, Clean 
with Issues, Revision Accepted 

Clean with Issues Represents the status when there are still 
outstanding edit exceptions after the edit 
process, but NYSED wants to include this 
data with the Clean form sets for processing. 

Valid prior status- Edit in Progress, 
Corrections Accepted, Revision Accepted 

Revision Submitted Represents the status after a school entity has 
submitted their revised data to NYSED. 
 Revisions refer to change requests made after 
the edit process has cleaned a form set. 
 Revisions will be reviewed for approval by 
NYSED before being accepted as official 
data.  Revisions not accepted by NYSED do 
not become part of the official data.  

Valid prior status- Clean, Clean with Issues 

Revision in Progress Represents the status after a school entity has 
submitted their revised data and NYSED has 
begun reviewing it. 

Valid prior status- Revision Submitted 

Revision Rejected Represents the status after a school entity has 
submitted their revised data and NYSED has 
rejected it.   

Valid prior status- Revision in Progress 



 

  Page 42 
 

Status Description 

Revision Accepted Represents the status after a school entity has 
submitted their revised data and NYSED has 
accepted it. 

Valid prior status- Revision in Progress 

Revision Queued Represents the status after a school entity has 
submitted their revised data and NYSED has 
queued it as a Prior Year Revision. 

Valid prior status- Revision Submitted 

Revision Queue Accepted Represents the status after NYSED has 
accepted data that was previously queued as a 
Prior Year Revision. 

Valid prior status- Revision Queued 
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Running the Edit Exception Reports 
 
Each form set has an Edit Exception Report associated with it. Edit Exception Reports can be 
accessed from the Form Tree just like the data entry forms. You can run an Edit Exception 
Report at any point. In order to certify your form sets, you must first run the Edit Exception 
Report associated with the form sets and ‘Ready’ the report by pressing the ‘Save & Ready’ 
button at the bottom of each report. 
 
1. Select the Edit Exception Report you want to run from the Form Tree. 
 
2. After the Edit Exception Report page loads, click on the Run Report button to run a new report. You 

must have the default setting, ‘Run New’, set in the drop down list box. (To see previously executed 
reports, select one from the drop-down list, and click on Run Report.) 

 

 
 
3. The results of the Edit Exception Report are displayed. All exceptions that are found are listed. You 

can use the Edit Exception Report to help you complete the form entry process by identifying 
problem areas in your data entry process, before you certify and submit to State Aid.  
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Important Information: All form sets must be certified by the school Superintendent 
before they are submitted to State Aid. Before you have access to the certification process 
for a particular form set, you must ‘Ready’ the Edit Exception Report associated with that 
form set.  

 
 
4. You can associate a comment with each exception occurring in the Edit Exception Report. To provide 

a comment, simply insert text in the comment text field provided with each exception generated. Each 
Edit Exception Report also has a general comment area at the bottom of the report, where you can 
associate a comment(s) with the entire report. To save comments without setting the Edit Exception 
Report to Ready, click on the Save Comments button. When you click on the Save and Ready 
button, any comments entered are automatically saved.  Comments entered for a particular edit will 
be displayed on subsequent runs of the Edit Exception Report. 
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Certifying Form Data 
 

Each form set has its own Certification Form that allows a school entity to officially certify and 
submit their data for the forms and schedules associated with a form set.  Only Superintendents 
will have access to the certification function. 

1. Go to the Form Tree under the Official Data area and open the Certification Form for 
the form set that you want to certify from within the Official Data Area. (In the example 
below, the form is shown near the bottom and is called ‘Form A Certification’. 
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2. Click on the Certify & Submit button.  The status of the associated form set will be 
changed to "Certified".  The forms within the certified form set will now be read-only to 
the school entity in the Official Data Area.  Any modifications to their certified data must 
occur in the Revision Data Area (see the Revising Data help topic for more information). 

 

 

 

Important Information: The Certify & Submit button is only accessible to those users 
who have been assigned the certification privilege. If you don’t have this privilege, you 
will not see this button.  In addition, a form set cannot be certified until its associated Edit 
Exception Report is in the Ready data state. 
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Unit 5: 
The Revision Process 

 
 
 

Unit Overview 
 
SAMS supports a mechanism for Districts to submit revisions to their State Aid data sets after 
they have been certified and submitted to NYSED. These revisions are reviewed by NYSED for 
their acceptance.  This unit provides an overview of how this process works.  
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About Data Areas 
 

Data Areas are used to logically separate data that is stored in the centralized SAMS database.  
The data displayed in, and used by, a Data Area is based on the data in the Official Data Area, 
overlaid with any changes made within a particular data area.  The following data areas are 
available to school entity users in SAMS: 

 Official Data Area:  Refers to all form data entered and saved through the Official Data 
submenu item located within the Forms main menu and to all change submissions 
accepted by NYSED.  Aid calculations and official reports are based on the data in the 
Official Data Area. 

 Revision Data Area:  Refers to all form data entered and saved through the Revision 
Data submenu item located within the Forms main menu.  The Revision Data area will 
be used to submit change requests for form sets that have been certified.  Change requests 
will address both change submissions (for changes made during the Claim Review 
Process) and revision requests (for changes made during the Revision Process).  Once 
accepted by NYSED, revised data is incorporated into the Official Data Area. 

 Sandbox Data Area:  Refers to all form data entered and saved through the Sandbox 
Data submenu item located within the Forms main menu.  The Sandbox Data Area can 
be used to “play” with a district’s data to see the effects that various changes to that data 
would have.  The Sandbox Data Area works the same way the Revision Data Area does, 
expect that updates made to a district’s data cannot be submitted for inclusion in the 
Official Data Area from the Sandbox Data Area.  The Change Submission forms in the 
Sandbox Data Area provide a summary of the changes made to the data in that Data Area 
and are also used to clear the data area of any changes that were made in it. 
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Revising Form Data 
 
SAMS allows school entity users to revise data that they have certified and officially submitted 
to NYSED.  All revisions must be entered and submitted to NYSED from the Revision Data 
Area.  Once accepted by NYSED, revision data is incorporated into the Official Data Area. 
 

1. Select the Revision Data area menu item from the Forms menu located near the top of the 
screen.  The Form Selection Tree is displayed for the Revision Data Area. 

 

 
 

2. Open the form that you want to revise. 
 

3. Enter your revisions and Save the form. 
 

4. From the Revision Data Area form selection tree, open the Change Submission form for the 
form set that you are revising.  Each form set has its own Change Submission form that allows 
you to review the pending revisions related to all of the forms within that form set and submit 
them to NYSED as a single request. 
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5. To submit the pending revisions that are summarized on the Change Submission form to 

NYSED, press the Submit Changes button on the form. 
 

 
 

6. To clear the pending revisions that are summarized on the Change Submission form from all of 
the associated forms in the Revision Data area, press the Clear Revisions button. 

 
7. NYSED will review the requested revision for acceptance into the Official Data Area.  Revisions 

submitted by school districts do not become part of a district’s official data until they are accepted 
by NYSED. 
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Unit 6: 
The Entity Information Screen 

 
 
 

Unit Overview 
 
In this unit, you will learn about the Entity Information Screen and how it can be used to obtain 
pertinent demographic and contact information associated with your district.  Information will 
also be presented on how to modify information associated with your district contacts.  
 
The SAMS Entity Information Screen is linked to another information system maintained by 
NYSED called SEDREF.  This system is a central repository maintained by NYSED that 
contains basic contact information about institutions that interact with NYSED. 
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Reviewing Entity Information 
 

To review Entity Information associated with your institution, take these steps: 

1. Select and click Entity Info from the SAMS main menu. 
 

2. SAMS loads the Entity Information screen and you can review all the current demographic 
information associated with your district. Information presented includes your district’s basic 
identifying attributes, such as District Code, BOCES Code, current Superintendent, and other 
attributes. 

 

 
 
 

Important Information: Most of the basic demographic information presented on the 
Entity Information screen is read-only. You do have the ability to Modify State Aid related 
contacts within SAMS. Information on this is presented below. 
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Updating the Official SAMS Contacts 
 

To update a contact associated with your institution, take these steps: 

1. Select and click Entity Info from the SAMS main menu. 
 

2. Click on the Edit Entry button associated with the contact that you want to update. 
 

3. A new screen will be displayed that allows you edit and update the information about that 
contact.  Click on the Edit Entry button after you have made your updates.  SAMS returns to the 
Entity Information screen.  The contact updates are now reflected on the screen. 
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Unit 7: 
Activity Log 

 
 
 

Unit Overview 
 
In this unit, you will learn about the Activity Log and how you can use it to review the history of 
activities associated with your district work and how to create your own user-defined activities. 
 
SAMS automatically generates activity log records when certain events occur, such as data state 
changes and email notifications to users of the system.  An additional feature within the Activity 
Log allows users with the appropriate security role privilege to create their own activity records 
which can record information exchange events that occurred outside of the application (e.g. an 
email, phone call, or fax to/from a district). 
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Reviewing the Activity Log 
 
To access the Activity Log follow these steps: 

1. Select and click Activity Log from the SAMS main menu. 
 

2. SAMS loads the Activity Log screen and you can review all the current activities associated with 
your district.  Information associated with each activity log record, includes the activity log id, 
claim year, form set, activity type, description, date, and user.  

 
SAMS provides the ability to filter the information presented to you in the activity log.  To filter, 
setup your filter preferences from the drop-down boxes provided and click the Apply Filter 
button. 
 
The results displayed in the Activity Log can also be sorted by clicking on the title of each 
column.  Click a column name once to sort by that column in Ascending order and click the 
same column name again to sort the results by that column in Descending order. 
 
The details of Correspondence items, and certain other items (e.g. revision submissions), can be 
viewed in a separate browser window by clicking on the hyperlinks provided for these items. 
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Adding a User-Defined Correspondence Activity 
 
To add a user-defined correspondence activity follow these steps: 

1. To add a correspondence activity, click the Add Corresp. Button on the Activity Log page which 
causes SAMS to load the Add Correspondence page.. 
 
NOTE:  A user must have the appropriate security role privilege in order to have access to this 
button.  The button will not appear if the user does not have the appropriate privilege assigned to 
their user role. 

 
2. On the Add Correspondence page select the Correspondence Type from the drop-down box list, 

the Form ID from the drop-down box, and fill in all the applicable text boxes. When you are 
ready to save the correspondence, click the Add Corresp. Button. 
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Unit 8: 
The Claim Verification Process 

 
 
 

Unit Overview 
 
In this unit you will learn about the Claim Verification (CV) process.  This process provides 
NYSED with an online method to track their progress towards verifying the accuracy of 
specified data that has been certified and submitted by school districts.  Districts will receive an 
email notification when NYSED initiates the Claim Verification process for a given year.  This 
notification will identify which districts have been selected to participate in the Claim 
Verification process for that year, as well as, provide additional information about the process to 
the districts. 
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Access the Claim Verification Project List 
The Claim Verification Project List identifies which Claim Verification projects have been 
defined for a particular Claim Year and whether or not a particular district has been selected to 
participate in the Claim Verification process for each of these projects. 
 
To access the Claim Verification Project List, follow these steps: 

1. Choose the Claim Year in the application header for which you want to view the Claim 
Verification Project List for and then click on the SET VALUES button. 

 
2. In the SAMS application navigate to Claim Verifications > Claim Verification Project 

List from the main menu.  The “Claim Verification Project List” screen will appear. 
 

The user is presented with a list of all the Claim Verification projects that have been 
assigned to the selected year.  The “Project Name”, “Project Description”, and  “District 
Action Required?” columns are displayed for the list.  The “District Action Required?” 
column displays a “Yes” or “No” to indicate if the selected district is required to 
participate in the Claim Verification process for this project in the selected year. 

 
 

Acknowledge Receipt of the Claim Verification Intent Notice 
Districts who have been selected to participate the Claim Verification process are required to 
acknowledge their receipt of the intent notice that they will receive via email when SED initiates 
the Claim Verification process for a particular year.  This acknowledgement must be performed 
for each Claim Verification project that a district has been selected to participate in. 
 
To acknowledge receipt of the Claim Verification Intent Notice, follow these steps: 

1. Choose the Claim Year in the application header for which you want to view a Claim 
Verification Project Form for and then click on the SET VALUES button. 

 
2. In the SAMS application navigate to Claim Verifications > Claim Verification Project 

List from the main menu.  The “Claim Verification Project List” screen will appear. 
 

3. Click on the Project Name of the project you want to work with. 
 

If the selected district is required to participate in the project, the user will see the full 
Claim Verification form.  For participating districts, the top of the form contains the date 
the district was notified by NYSED of their intent to review, the date that any materials 
are due, and the date the district acknowledged receipt of the notification of intent to 
review.   
 
If the district has not yet acknowledged receipt of the notification of intent to review, they 
will be provided a hyperlink to perform this action.  Clicking this link will save the 
acknowledgement date for the districts (refer to the next step).  If the district has already 
acknowledged receipt of the intent notification, the user will see the date they performed 
this action. 
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If the district is not required to participate, a smaller, modified version of the form is 
shown.  This smaller version only includes the project fields that are being reviewed and 
the project explanation/instructions. 

 
4. Click on the hyperlink provided to acknowledge receipt of the intent notification.   

 
 

Enter a Comment on a Claim Verification Project Form 
Claim Verification project forms are defined each year for use in tracking the process of 
verifying the accuracy of specified data that has been certified and submitted by school districts.  
District users are able to enter comments on these forms. 
 
To enter a comment on a Claim Verification Project Form, follow these steps: 

1. Choose the Claim Year in the application header for which you want to view a Claim 
Verification Project Form for and then click on the SET VALUES button. 

 
2. In the SAMS application navigate to Claim Verifications > Claim Verification Project 

List from the main menu.  The “Claim Verification Project List” screen will appear. 
 

3. Click on the Project Name of the project you want to work with. 
 

If the selected district is required to participate in the project, the user will see the full 
Claim Verification form.  For participating districts, the top of the form contains the date 
the district was notified by SED of their intent to review, the date that any materials are 
due, and the date the district acknowledged receipt of the notification of intent to review.  
If the user is a District user and has not yet acknowledged receipt of the notification of 
intent to review, they will get a hyperlink saying “Districts, Click here to acknowledge 
receipt of notification of intent.”  Clicking this link will save the acknowledgement date 
for the districts.  If the district has acknowledged, the user will see the date they 
performed this action. 

 
If the district is not required to participate, a smaller, modified version of the form is 
shown.  This smaller version only includes the project fields that are being reviewed and 
the project explanation/instructions.  Comments cannot be entered on Claim Verification 
forms for a project that a district has not been selected to participate in. 

 
4. To add a new comment, the user will type the comment details into the text area labeled 
“New Comment” and press the “Save Form” button.  Comments show on the form in 
descending order of created date. 
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Review the Claim Verification Activity Log 
SAMS automatically generates Claim Verification Activity Log records when certain Claim 
Verification events occur.  Users can review and filter these activity records. 
 
To review the Claim Verification Activity Log, follow these steps: 

1. In the SAMS application, navigate to Claim Verifications > Claim Verification 
Activity Log from the main menu.  This screen will show a default activity log filtered 
only by Claim Year and district Name/BEDS Code set in the header of the application. 

 
2. Users can choose a variety of filter options to narrow the scope of the list. 

a. Project List – Filters by a specific project. 
b. CV Activity Type – Filters by correspondence, due date, notice, or status date. 
c. Date Range – Start and end dates used to narrow the displayed results based on 

comparison against the Date of each activity. 
 

3. After selecting filter options, click the “Apply Filter” button to apply the filter options. 
 
Note:  The log has the ability to sort all columns by clicking the column name, which is a 
hyperlink.  The default sort is by Date, descending.  Clicking a column that is already the sorted 
column will change the direction of the sort (e.g. from descending to ascending).  If an activity is 
a correspondence, the activity type will show as a hyperlink.  Clicking this link will show the 
details of the correspondence that is tied to this activity. 
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Unit 9: 
Output Reports 

 
 
 

Unit Overview 
 
In this unit you will learn about viewing and printing Output Reports.  These reports are used to 
display the amount of State Aid to be paid to a district. 
 
 

View or Print Output Reports from SAMS 
To view or print an Output Report within SAMS, follow these steps: 
 

1. Select the Claim Year in the application header for which you want to view the Output 
Report and then click on the SET VALUES button. 

 
2. In the SAMS application navigate to Reports > Output Reports from the main menu.   

 
The Output Report selection screen will appear.  The reports available in the tree are 
based on the Claim Year that is set in the application header. 

 
3. Select a Data Area and Data Version Date. 

 
The Data Area selection specifies which Data Area the report will retrieve data from and 
the Data Version Date selection determines what version of data the report will retrieve.  
See the “About Data Areas” section in this manual for more information about Data 
Areas. 

 
4. Select a report version to view from the selection tree by clicking on it. 

 
The Output Report will be displayed and link will be available to print the Output Report.  
A separate window will open with a printer friendly version of the Output Report after 
clicking on the Print Form link.  Use the browser’s print functionality to print the report.  
To close the newly opened browser window, you must click on the ‘X’ box in the upper 
right hand corner of the browser window or press ‘CTRL+W’ when that window is 
active. 
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Not Available - Coming Soon 
 

View or Print Output Reports from the State Aid Public Website 
To view or print an Output Report from the State Aid public website, follow these steps: 

1. Navigate to the public URL. 
 

2. Select a School Year. 
 

3. Enter a District Name or BEDS Code. 
 

4. Click on the Submit button.  A list of Output Reports for the given School Year and 
District will be displayed as hyperlinks. 

 
5. Click on the name of a report to view it.  Use the browser’s print functionality to print the 

report. 
 
Notes: 

o A partial District Name or BEDS Code can be entered and a list of matching districts will 
be displayed after clicking on the submit button.  Leave both the District Name and 
BEDS Code blank to retrieve the full list of districts. 

o The list of publicly viewable Output Reports will only be displayed for Major and Big 5 
School Districts whose primary form sets (A, FB, FT, and ST-3) are in the CLEAN or 
greater data state.  
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